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About This Guide

This guide describes how to install and configure Novell® ClientTM for Linux Beta 3 software.

This guide is intended for network administrators and is divided into the following sections:

Chapter 1, “Understanding the Novell Client for Linux,” on page 9

Chapter 2, “Novell Client for Linux Virtual File System,” on page 11

Chapter 3, “Installing the Novell Client for Linux,” on page 17

Chapter 4, “Configuring Novell Client for Linux,” on page 23

Chapter 5, “Managing Login,” on page 27

Chapter 6, “Managing File Security,” on page 31

Chapter 7, “Uninstalling Novell Client,” on page 35

Appendix A, “Troubleshooting Issues,” on page 37

Appendix B, “Commands,” on page 39

Additional Documentation

For documentation on known issues, see the Novell Client for Linux Readme

For documentation on login scripts, see the Novell Login Scripts Guide.

For documentation on the Novell Client tray application, see the Novell Client for Linux User 
Guide.

For documentation on the command line utilities, see the man pages associated with these utilities. 

Documentation Updates

For the latest version of this documentation, see the Novell Clients online documentation (http://
www.novell.com/documentation/beta/linux_client/index.html).

Documentation Conventions

In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
within a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for 
other platforms, the pathname is presented with a backslash. Users of platforms that require a 
forward slash, such as Linux*, should use forward slashes as required by your software.
About This Guide 7
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1 Understanding the Novell Client for Linux

Novell Client for Linux software allows users of Linux workstations to access and use all of the 
services available on servers running Novell eDirectory. Novell Client brings the full power, ease 
of use, manageability, and security of eDirectory to Linux workstations. Novell Client for Linux 
fully supports NetWare, OES, and eDirectory services and utilities on a Linux workstation, 
including integrated messaging, multiprotocol support, management, security, and file and print 
services. 

Novell Client for Linux Requirements
Novell Client for Linux requires that the workstation be running one of the following: 

(Preferred) NLD 9 SP2 or later
WARNING: Trimmed down versions of NLD may have problems due to missing packages.

NLD 9 SP1 

SuSe Pro 9.3

If workstations are not running NLD 9 SP2, there are additional required packages that must be 
installed. For more information on the required packages, see “Preparing Workstations to Compile 
the Virtual File System Kernel Module” on page 12.

Understanding How Novell Client for Linux Differs from Novell 
Client for Windows 2000/XP

The Novell Client for Linux differs in a few ways from the Novell Client for Windows. For users 
and network administrators who have used the Novell Client for Windows, knowing these 
differences will help the transition to Linux occur more smoothly. 

Novell Client for Linux can be installed and upgraded using either the YaST and Red Carpet 
installation methods. In addition, the Client Configuration Wizard allows you to set up a 
configuration file that can be used to preconfigure workstations during installation. There is 
no Automatic Client Upgrade available on Linux. For more information, see Chapter 3, 
“Installing the Novell Client for Linux,” on page 17.

Novell Client Login is not integrated in to initial workstation login. Once you are logged in to 
the workstation, you must log in from the Novell tray application. Additionally, this means 
that there is no username or password synchronization with the workstation username and 
password. 

When a user logs in to a local workstation and then opens a remote SSH session and logs in 
as the same user, the network resources are available to the user.
Understanding the Novell Client for Linux 9
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The NMAS login is not integrated in to the Novell Client for Linux login screen so the default 
login sequence cannot be set in the Novell Client Login screen. However, the Novell Client 
for Linux can use the NMAS login methods to authenticate.

Novell Client for Linux uses OpenSLP whereas Windows uses Novell’s implementation of 
SLP. The network administrator must set up OpenSLP before users can see trees, contexts, 
and servers in the Novell Client Login window. Because Linux uses OpenSLP, the 
implementation is different and the user’s experience will be different. For more information, 
see “Using OpenSLP to Simplify Login” on page 28.

Novell Client for Linux does not use the Dynamic Local User or Location Profiles that were 
available in Windows.

Both a graphical user interface and command line utilities are available to complete client 
actions like mapping drives, setting trustee rights, and copying files.

Novell Client for Linux uses XTier.

Novell has been able to port the vast majority of login script functionality over to the Linux 
platform. This means that the login scripts you create in your network will work for both 
Windows users and Linux users with very little difference in functionality. 

Some difference do exist. For example, mapped drives are created by creating symbolic links 
and search drives are not available on Linux.

Other small differences are created by the inherit difference between Windows and Linux. All 
the differences and issues are listed in the Novell Login Scripts Guide. 

Additional Information
Chapter 2, “Novell Client for Linux Virtual File System,” on page 11

Chapter 3, “Installing the Novell Client for Linux,” on page 17

Chapter 4, “Configuring Novell Client for Linux,” on page 23

Chapter 5, “Managing Login,” on page 27

Chapter 6, “Managing File Security,” on page 31

Chapter 7, “Uninstalling Novell Client,” on page 35
10   Novell Client for Linux Installation and Administration Guide
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2 Novell Client for Linux Virtual File System

Novell® ClientTM for Linux differs from previous Novell Clients in order to work on the Linux 
platform. In Windows, the Novell Client loaded a single binary that worked on multiple operating 
system platforms without modifications. The Novell Client for Linux has a Virtual File System 
that consists of a kernel module (novfs.ko) that runs as part of the Linux kernel and a daemon 
(novfsd) that runs in the user space. Both components must be running on the workstation for the 
client to connect to the network. 

The daemon can run on any of the supported Linux platforms without modification. The kernel, 
however, is kernel-version-dependent and can only run on NLD 9 SP2 without modification 
because it is included in the NLD 9 SP2 distribution. This is why NLD 9 SP2 is listed as the 
preferred platform version for Novell Client for Linux. 

This section explains how to determine if you need to compile the kernel and how to install the 
required packages and compile the kernel.

“Understanding when the Virtual File System Kernel Module Needs to be Compiled” on 
page 11

“Preparing Workstations to Compile the Virtual File System Kernel Module” on page 12

“Compiling the Novell Client Virtual File Sysem Kernel Module” on page 15

Understanding when the Virtual File System Kernel Module Needs 
to be Compiled

If you are not running NLD 9 SP2 or have modified your kernel in any way, you must compile the 
Novell Client Virtual File System Kernel Module (novfs.ko) in order for the Novell Client to run 
on that workstation. In order to compile the novfs.ko kernel, specific packages must be installed 
on the workstation. 

The following is a list of the instances when you must compile the Novell Client Virtual File 
System Kernel Module (novfs.ko): 

If you are running a previous versions NLD 9 

If you are running SuSE Pro 9.3

If you patched the NLD 9 SP2 kernel for any reason

If you have previously compiled the Novell Client Virtual File System Kernel Module 
(novfs.ko) and then have made changes to the kernel

 If you have a custom kernel of any of the supported versions including NLD 9 SP2

If kernel updates are pushed to the workstation via Red Carpet automatically

In all these instances, you must recompile the Novell Client Virtual File System Kernel Module 
(novfs.ko) to ensure that it is compatible with the Linux kernel version on your workstation. 
Novell Client for Linux Virtual File System 11
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However, when later shipping versions of NLD are provided by Novell, the Novell Client Virtual 
File System Kernel Module (novfs.ko) is installed and you will not need to recompile since the 
module is included in the kernel. 

Additional Things to Consider 
There are two things to note when discussing the need to compile the Novell Client Virtual File 
System Kernel Module:

Compiling the Novell Client Virtual File System Kernel Module is done on one workstation. 
If you are deploying the Novell Client for Linux to multiple workstations, you can compile 
the kernel module on one workstation and then use any of your software distribution channels 
to deploy the updated Novell Client for Linux to workstations.

Under certain conditions, your version of novfs.ko could be revved back when you install a 
new kernel module. This happens because novfs.ko is part of the NLD 9 SP2   For example, 
if you downloaded a patched version of novfs.ko, installed it and then later you installed an 
NLD 9 SP2 update to your kernel, the Novell Client Virtual File System Kernel Module patch 
may be overwritten. You would have to reinstall the novfs.ko patch and recompile the kernel 
in order to ensure that the kernel module and the kernel were compiled. 

If possible, the best way to simplify Novell Client for Linux deployment is to run NLD 9 SP2 on 
the workstation and not to update the kernel unless it is to the next shipping version of NLD. 
However if your workstation is running one of the other supported platforms or if you must update 
your kernel, see Chapter 2, “Novell Client for Linux Virtual File System,” on page 11 for specific 
instructions on what packages are required and how to compile the Novell Client Virtual File 
System Kernel Module. 

Understanding the Steps to Compiling the Novell Client Virtual File 
System Kernel Module

Compiling the Novell Client Virtual File System Module takes three steps: 

1 Ensuring that the right packages are installed on your workstation so that the the kernel 
module can be compiled. 

See “Preparing Workstations to Compile the Virtual File System Kernel Module” on page 12.

2 Installing the Novell Client software so that the kernel module pieces are on the workstation.

See “Installing the Novell Client for Linux” on page 17.

3 Compiling the Novell Client Virtual File System Kernel Module.

See “Compiling the Novell Client Virtual File Sysem Kernel Module” on page 15.

Preparing Workstations to Compile the Virtual File System Kernel 
Module

Before you can compile the Novell Client Virtual File System Kernel Module, the workstation 
must have several packages installed in order to compile the kernel module. 
NOTE: If you are required to compile the kernel module even though you are running NLD 9 SP2, complete 
these steps. For more information on when you must compile even though you are running NLD 9 SP2, see 
“Additional Things to Consider” on page 12.
12   Novell Client for Linux Installation and Administration Guide
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The following packages must be installed before you comile the Novell Client Virtual File System 
Kernel Module:

gcc

kernel-source

kernel-syms 

make

gettext (installed by default)

libgcj (installed by default)
NOTE: If you update your Linux kernel version at any time, you must repeat these steps, install the Novell 
Client, and then compile the Novell Client kernel loadable module (novfs.ko) again so that it matches the new 
kernel version and reinstall the Novell Client for Linux. See “Installing the Novell Client for Linux” on page 17 
and “Novell Client for Linux Virtual File System” on page 11. ONE OR THE OTHER Reinstall-uninstall all the 
stuff is taken off and during the all client settings wiped out. 

After you have installed the required packages, install Novell Client for Linux. 

Installing Required Packages from XWindows
If workstations are not running NLD 9 SP2, you must install the required packages and compile 
the kernel before installing Novell Client for Linux.

Launching the YaST Control Center

1 From the System menu, select Administrator Settings.

2 In the Run as Root window, type the root password, then click OK.

3 Proceed to “Adding the Required Packages” on page 13.

Adding the Required Packages

1 Select the Software tabbed page and then select Install and Remove Software. 

2 In the Filter menu, select Search.

3 Type gcc in the Search field and then click Search.

4 Select the gcc package.

5 Type kernel-source in the Search field and then click Search.

6 Select the kernel-source package for installation.
WARNING: The version of the kernel-source package you select for installation must match the version 
of the kernel currently installed on the Linux machine

7 Type kernel-syms in the Search field and then click Search.
WARNING: The version of the kernel-syms package you select for installation must match the version 
of the kernel currently installed on the Linux machine

8 Select the kernel-syms package for installation.

9 Type make in the Search field and then click Search.

10 Select the make package for installation.

11 Click Accept to install all of the selected packages.
Novell Client for Linux Virtual File System 13
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YaST displays the progress of the package installation. 

12 (Conditional) If a dialog informs you that other package selection have been made to resolve 
dependencies, click Continue.

13 (Conditional) If a dialog prompts you to insert the Novell Linux Desktop CD, put the cd in the 
CD-ROM drive and then click OK.

14 After all the packages have been installed, select Close to close the YaST Control center.

15 Proceed to “Installing the Novell Client for Linux” on page 17.

16 When the installation is complete, proceed to “Compiling the Novell Client Virtual File 
Sysem Kernel Module” on page 15. 

Installing the Required Packages from the Console Terminal
If workstations are not running NLD 9 SP2, you must install the required packages and compile 
the kernel before installing Novell Client for Linux.

Launching the YaST Control Center

1 Launch the YaST Control Center by entering the following to display the YaST Control 
Center:

Launch /sbin/yast
2 Proceed to “Adding the Required Packages” on page 14.

Adding the Required Packages

1 Select Software, then select Install and Remove Software. 

2 Select Filters and then select Search.

3 Enter gcc in the Search field and then press Enter.

4 Select the gcc package for installation and press Enter.

The Plus (+) key appears next to the gcc package in the list.

5 Type Filters and then select Search.

6 Type kernel-source in the Search field and then press Enter.

7 Select the kernel-source package for installation and press Enter.

The Plus (+) key appears next to the kernel-source package in the list.
WARNING: The version of the kernel-source package you select for installation must match the version 
of the kernel currently installed on the Linux machine.

8 Type kernel-syms in the Search field and then press Enter.
WARNING: The version of the kernel-syms package you select for installation must match the version 
of the kernel currently installed on the Linux machine

9 Select the kernel-syms package for installation and then press Enter.

10 Type make in the Search field and then press Enter.

11 Select the make package for installation and then press Enter.

12 Select Accept to install all of the selected packages, then press Enter.

YaST displays the progress of the package installation. 
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13 (Conditional) If a dialog prompts you to insert the Novell Linux Desktop CD, put the cd in the 
CD-ROM drive and then press Enter.

14 After all the packages have been installed, select Close to close the YaST Control center.

15 Proceed to “Installing the Novell Client for Linux” on page 17.

16 When the installation is complete, proceed to “Compiling the Novell Client Virtual File 
Sysem Kernel Module” on page 15. 

Compiling the Novell Client Virtual File Sysem Kernel Module
Depending on whether or not you have a standard kernel that has been updated or a custom kernel 
that needs to have the Novell Client Virtual File System kernel module added, the steps to 
compiling the Novell Client Virtual File System Kernel differ. 

Compiling the Novell Client Virtual File System Kernel Module After a Kernel 
Update

If you have updated the kernel on the workstation, you must compile the Novell Client virtual file 
system kernel module so that it works with the updated kernel. 
IMPORTANT: If you have updated your kernel, make sure you restart the workstation before compiling the 
Novell Client Virtual File System Kernel module. 

1 From the terminal, login as root.

2 Type the following command: 

cd /opt/novell/ncl/src/novfs directory
3 Type the following command:

./make

The Novell Client Virtual File System Module is updated to match your custom kernel.

Compiling the Novell Client Virtual File System Kernel Module on Workstations 
Running a Custom Kernel

If you have a custom kernel on the workstation, you must compile the Novell Client Virtual File 
System kernel module so that it works with the custom kernel. 
IMPORTANT: If you have updated your kernel, make sure you restart the workstation before compiling the 
Novell Client Virtual File System Kernel module. 

1 From the terminal, login as root.

2 Type the following command: 

cd /opt/novell/ncl/src/novfs directory
3 Type the following command:

./m

The Novell Client Virtual File System Module is updated to match your custom kernel.
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Additional Information
Chapter 3, “Installing the Novell Client for Linux,” on page 17

Chapter 4, “Configuring Novell Client for Linux,” on page 23

Chapter 5, “Managing Login,” on page 27

Chapter 6, “Managing File Security,” on page 31

Chapter 7, “Uninstalling Novell Client,” on page 35
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3 Installing the Novell Client for Linux

This section explains how to install Novell® ClientTM for Linux software on one workstation and 
includes the following sections:

“Installing Novell Client using an Installation Script” on page 17

“Installing Novell Client Using XWindows” on page 17

“Installing Novell Client from the Console Terminal” on page 19

“Installing Novell Client using Red Carpet” on page 20

“Start/Restart Novell Client for Linux” on page 21
WARNING: Before proceeding with the installation, make sure that you have configured your workstation 
correctly. See Chapter 2, “Novell Client for Linux Virtual File System,” on page 11.

Installing Novell Client using an Installation Script
An installation script is provided at the root of the Novell Client CD called ncl_install.bsh. This 
script can be used to install, verify installation, and uninstall the Novell Client directly from the 
command prompt using documented RPM commands rather than using the other automated 
installation methods. This same script is copied to the /opt/novell/ncl/bin directory during the 
installation of the Client, for later use to verify or uninstall the Client. 

To install using the installation script, type the following command in the command terminal: 

./ncl_install.bsh install
To force the installation using the installation script, type the following command in the command 
terminal: 

./ncl_install.bsh install force
To test the installation using the installation script, type the following command in the command 
terminal: 

./ncl_install.bsh install test
To verify the installation using the installation script, type the following command in the command 
terminal: 

./ncl_install.bsh verify

Installing Novell Client Using XWindows
WARNING: If you are updating the Novell Client software from Beta 2, make sure you uninstall the Beta 2 
software before you install Beta 3. See “Uninstalling Novell Client” on page 35. Also, make sure you have all 
the required packages. Additional packages are required in Beta 3. See “Novell Client for Linux Virtual File 
System” on page 11. Then follow the installation instructions in “Installing from XWindows” on page 18. 
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Installing the Novell Client using XWindows requires that you complete the following tasks: 

1 “Adding Novell Client Software to YaST using XWindows” on page 18.

2 “Installing from XWindows” on page 18.

3 “Start/Restart Novell Client for Linux” on page 21

Adding Novell Client Software to YaST using XWindows
1 Launch the YaST Control Center

1a From the System menu, select Administrator Settings.

1b In the Run as Root window, type the root password, then click OK.

2 Select the Software tabbed page in the left column to activate it and then select Change Source 
of Installation in the right column. 

3 Click Add.

4 Select the Novell Client source file location (CD or Local Directory only for Beta 3), and 
specify the location, then click Finish.
NOTE: YaST allows you to choose other installation sources such as FTP, HTTP, Samba, NFS, and DVD. 
These other sources have not been tested with the installation of Beta 3 but may work. You may want to 
try these other sources in your testing of Beta 3.

YaST adds the new installation source and displays it in the Software Source Media list. You must 
now install the software. 

Installing from XWindows
WARNING: If you are updating the Novell Client software from Beta 2, make sure you uninstall the Beta 2 
software before you install Beta 3. See “Uninstalling Novell Client” on page 35. Also, make sure you have all 
the required packages. Additional packages are required in Beta 3. See “Novell Client for Linux Virtual File 
System” on page 11. Then follow the installation instructions in “Installing from XWindows” on page 18. 

1 Launch the YaST Control Center

1a From the System menu, select Administrator Settings.

1b In the Run as Root window, type the root password, then click OK.

2 Select the Software tabbed page in the left column to activate it and then select Install and 
Remove Software in the right column. 

3 Change the filter to Selections.

4 Check the Novell Client for Linux checkbox to automatically select all of the packages for 
installation. 

5 Click Accept to install all of the selected packages.

The installation begins. 

6 Start Novell Client for Linux.

See “Start/Restart Novell Client for Linux” on page 21.

You may want to customize your Novell Client Options such as the placement of the Novell Client 
tray application on the Desktop or in the apps tray. This can be done from the Novell Client tray 
application.
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Installing Novell Client from the Console Terminal
WARNING: If you are updating the Novell Client software from Beta 2, make sure you uninstall the Beta 2 
software before you install Beta 3. See “Uninstalling Novell Client” on page 35. Also, make sure you have all 
the required packages. Additional packages are required in Beta 3. See “Novell Client for Linux Virtual File 
System” on page 11. Then follow the installation instructions in “Installing from the Console Terminal” on 
page 19. 

You can install or update the Novell Client from the Console Terminal. 
IMPORTANT: You must be logged in as the root user to install from the Console Terminal. 

Make sure you “Start/Restart Novell Client for Linux” on page 21 after you install the Novell 
Client. 

Installing from the Console Terminal
WARNING: If you are updating the Novell Client software from Beta 2, make sure you uninstall the Beta 2 
software before you install Beta 3. See “Uninstalling Novell Client” on page 35. Also, make sure you have all 
the required packages. Additional packages are required in Beta 3. See “Novell Client for Linux Virtual File 
System” on page 11. Then follow the installation instructions in “Installing from XWindows” on page 18. 

It should also be noted that if you installed previously from a location and you are installing an update, you 
must select a new source of installation. YaST cannot use the old location. 

1 Launch the YaST Control Center by entering the following to display the YaST Control 
Center:

Launch /sbin/yast
2 Select Software and then select Change Source of Installation. 

3 Select Add.

4 Select the Novell Client source file location (CD or Local Directory only for Beta 3), and 
specify the location, then select OK.
NOTE: YaST allows you to choose other installation sources such as FTP, HTTP, Samba, NFS, and DVD. 
These other sources have not been tested with the installation of Beta 3 but may work. You may want to 
try these other sources in your testing of Beta 3.

5 Select Software and then select Install and Remove Software. 

6 Change the filter to Selections.

7 Select the Novell Client for Linux to select all of the packages for installation, then press enter.

The Plus (+) key appears next to the Novell Client for Linux package in the list.

8 Select Accept to update all the selected packages. 

YaST displays the progress of the package installation. 

9 After all the packages have been installed, select Quit to close the YaST Control center.

10 Start Novell Client for Linux.

See “Start/Restart Novell Client for Linux” on page 21.

YaST updates the new installation source and displays it in the Software Source Media list.
Installing the Novell Client for Linux 19



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
Installing Novell Client using Red Carpet
WARNING: If you are updating the Novell Client software from Beta 2, make sure you uninstall the Beta 2 
software before you install Beta 3. See “Uninstalling Novell Client” on page 35. Also, make sure you have all 
the required packages. Additional packages are required in Beta 3. See “Novell Client for Linux Virtual File 
System” on page 11. Then follow the installation instructions in “Installing from XWindows” on page 18. 

Installing Novell Client Using XWindows

Launching Red Carpet

1 From the System menu, select Software Updates.

2 In the Run as Root window, type the root password, then click OK.

3 Select the Software tabbed page in the left column to activate it and then select Change Source 
of Installation in the right column. 

Activating the Required Red Carpet Service

1 From the Edit Menu, select Services.

2 Click Add Service.

3 Enter the Service URL included in the Beta information.

4 Click OK. 

The staging service is added to the Services list

5 Click Close.

6 From the File Menu, select Activate.

7 Select the Beta staging service in the Service list.

8 Enter your email address in the Email field.

9 Enter the activation code included in the Beta information.

10 Click Activate. 

Subscribe to the Novell Client for Linux Channel

1 Click Channels.

2 Select the channel included in the Beta information.

3 Click Close.

Select the Novell Client for Linux Packages for Installation

1 Click the Available Software tabbed page. 

2 Select the channel included in the Beta information.

3 Select all of the displayed packages.

4 Click Mark for Installation. 

Install Novell Client for Linux

1 Click Run Now.
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2 Click Continue on the Dependency Resolution dialog box. 

Red Carpet displays the progress of the package installation

3 After all the packages have been installed, click OK on the Transaction Finished dialog and 
quit Red Carpet. 

Installing Novell Client from the Console Terminal
1 Activate the required Red Carpet service by entering:

rug sa https://beta_URL
2  Select the Novell Client for Linux packages for installation by entering:

rug sub beta_package_name
3 Do one of the following to install or upgrade the Novell Client for Linux.

To install, enter the following:

launch rug in --beta_package_name
To upgrade, enter the following:

launch rug up beta_package_name
rug will list all the packages to be installed or upgraded, type y to continue.

rug will display the progress of the package installation.

Start/Restart Novell Client for Linux
There are several options to start or restart the Novell Client for Linux. 

Restarting the Linux Workstation: This is the best way to ensure that the Novell Client for 
Linux is completely restarted.

Manually Starting Novell Client: Open a terminal session and log in as root (su). Then type 
the following two commands, selecting the appropriate command based in whether or not this 
is a new installation or an update: 

For New Installations: ./novell/ncl/bin/ncl_control.bsh start
For Updates: ./novell/ncl/bin/ncl_control.bsh restart
If either of these commands displays any errors, you will need to restart the Linux machine. 

In addition, ./novell/ncl/bin/ncl_control.bsh status will show whether 
the NCL drivers are loaded properly or not.

Additional Information
Chapter 4, “Configuring Novell Client for Linux,” on page 23

Chapter 5, “Managing Login,” on page 27

Chapter 6, “Managing File Security,” on page 31

Chapter 7, “Uninstalling Novell Client,” on page 35
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4 Configuring Novell Client for Linux

This chapter explains the two ways that Novell Client for Linux provides to configure client 
settings on the workstation. 

“Using Novell Client Configuration Wizard” on page 23

“Using Configuration Files to Preconfigure Novell Client” on page 23

Using Novell Client Configuration Wizard
Novell Client for Linux includes a Novell Client Configuration Wizard to simplify the process of 
configuring your Novell Client.

1 Do one of the following: 

From the Novell Client tray application, select System Settings.

Launch YaST and select Novell Client from the Network Services list. 

2 Select the client configuration wizard pages that contain the settings you need to configure. 

3 Click Start Wizard.

4 Follow the instructions in the left panel to configure Novell Client settings. 

5 When finished, click Finish. 

Any changes you make to the Client settings are written to a set of conf files in the /etc/opt/novell/
ncl directory. These conf files are then used by the Client.
IMPORTANT: In Beta 3, the settings on the File Browser and Tray Application page are written to the conf file 
successfully but they are not used by those applications. This will be fixed for the open beta.

Using Configuration Files to Preconfigure Novell Client
Novell Client for Linux allows you to apply preconfigured client settings contained in one or more 
preconfigured conf files. This option works similar to the unattend file that can be used to 
configure Novell Client for Windows.

Preconfiguring Novell Client for Linux requires a spec file and a bash script found in the /add-on/
novell-client-conf directory of the Client.

1 Create the preconfigured settings using the Novell Client Configuration Wizard.

See “Using Novell Client Configuration Wizard” on page 23.

2 Copy the resulting conf files to the add-on/novell-client-conf directory.

Depending on the settings you preconfigured, you will need to copy one or more of the 
following files: 
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3 Run the make_novell-client-conf_rpm.bsh script.

This creates the novell-client-conf.rpm using all of the conf files contained in the add-on/
novell-client-conf directory. 

4 Do one of the following to install the preconfigured settings contained in the novell-client-
conf.rpm:

Install Manually from the Command Prompt: Type rpm -i novell-client-
conf.rpm at the command prompt

Install using the Provided ncl_install.bsh Script: When you launch the ncl_install.bsh 
script, it will look for the novell-client-conf.rpm in the add-on/novell-client-conf 
directory and add it to the list of rpms that it installs as part of the Client.

Install with the Novell Client using Red Carpet: Include the novell-client-conf.rpm in 
the channel with the rest of the Novell Client rpms and it will be installed with them.

Install with the Novell Client using YaST: Add the location of the newly created novell-
client-conf.rpm to the list of Installation Sources in YaST (add a Local Directory in the 
Change Source of Installation option and point it to the directory containing the novell-
client-conf.rpm). When the YaST install runs, the novell-client-conf.rpm will be added as 
one of the rpms in the Novell Client selection.
TIP: The configuration settings can be updated on the workstation using this method at any time. 
See “Updating Client Configuration Settings at Any Time” on page 24.

The conf files contained in the rpm are copied into the /etc/opt/novell/ncl directory, 
overwriting the files of the same name that already exist there. 

The installation then copies the slp.conf file to the /etc directory, overwriting that file as well. 
TIP: Backup copies of the existing files are made so that you can revert back to the old files if you need to.

Updating Client Configuration Settings at Any Time
Any time you need to update Novell Client settings on a workstation, you can use the 
Configuration Wizard to 

1 Create the preconfigured settings using the Novell Client Configuration Wizard.

See “Using Novell Client Configuration Wizard” on page 23.

2 Copy the resulting conf files to the add-on/novell-client-conf directory.

Depending on the settings you preconfigured, you will need to copy one or more of the 
following files: 

Configuration Settings Conf File Path and Name

Login Settings /etc/opt/novell/ncl/login.conf

Protocol Settings /etc/opt/novell/ncl/protocol.conf

File Browser Settings /etc/opt/novell/ncl/file_browser.conf

Novell Client Tray Application Settings /etc/opt/novell/ncl/tray_app.conf

SLP Configuration Settings /etc/opt/novell/ncl/slp.conf
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3 Run the make_novell-client-conf_rpm.bsh script.

This creates the novell-client-conf.rpm using all of the conf files contained in the add-on/
novell-client-conf directory. 

4 Add the location of the newly created novell-client-conf.rpm to the list of Installation Sources 
in YaST (add a Local Directory in the Change Source of Installation option and point it to the 
directory containing the novell-client-conf.rpm). When the YaST install runs, the novell-
client-conf.rpm will be added as one of the rpms in the Novell Client selection.

The conf files contained in the rpm are copied into the /etc/opt/novell/ncl directory, 
overwriting the files of the same name that already exist there. 

The installation then copies the slp.conf file to the /etc directory, overwriting that file as well. 
TIP: Backup copies of the existing files are made so that you can revert back to the old files if you need to.

Additional Information
Chapter 5, “Managing Login,” on page 27

Chapter 6, “Managing File Security,” on page 31

Chapter 7, “Uninstalling Novell Client,” on page 35

Configuration Settings Conf File Path and Name

Login Settings /etc/opt/novell/ncl/login.conf

Protocol Settings /etc/opt/novell/ncl/protocol.conf

File Browser Settings /etc/opt/novell/ncl/file_browser.conf

Novell Client Tray Application Settings /etc/opt/novell/ncl/tray_app.conf

SLP Configuration Settings /etc/opt/novell/ncl/slp.conf
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5 Managing Login 

You can customize the client login environment to suit your network and have greater control over 
what users can access during login.

“Setting Up Login Scripts” on page 27

“Setting Up Login Restrictions” on page 27

“Logging In to the Network” on page 29

“Logging Out of the Network” on page 29

Setting Up Login Scripts
When a user successfully logs in to the network, one or more login scripts are executed which 
automatically set up the workstation environment. Login scripts are similar to batch files and are 
executed by Novell® Login. You can use login scripts to map drives and search drives to 
directories, display messages, set environment variables, and execute programs or menus.

Login Scripts were originally created for use with the Novell Client for Windows. However, 
Novell Client for Linux can take advantage of the majority of the functionality available in 
Windows. This means that the login scripts you created for Windows workstations can also be 
used with Linux workstations without having to modify them. This means that you only have to 
administer one set of login scripts. 

Because login scripts are very flexible and dynamic, offer a high degree of customization, and are 
cross-platform, you will want to customize the scripts to optimize workstation login to your 
network. For more information on setting up login scripts, see the Novell Login Scripts Guide.

Setting Up Login Restrictions
Login restrictions are limitations on user accounts that control access to the network. These 
restrictions can be set by an administrator in Novell iManager or ConsoleOne® for each user’s 
eDirectory User object and include the following:

Requiring a password 

You can specify its minimum length, whether it must be changed and how often, whether it 
must be unique, and whether the user can change it. 

Setting the number of logins with expired password and the number of incorrect login 
attempts allowed

Setting account limits such as an account balance or expiration date

Limiting disk space for each user by specifying the maximum blocks available for each user 
on a volume
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Specifying the number of simultaneous connections a user can have

Specifying (by node address) which workstations users can log in on

Restricting the times when users can log in (you can assign all users the same hours, or you 
can restrict users individually)

When a user violates login restrictions by entering an incorrect password or the exceeding the 
number of logins with an expired password, the account is disabled and no one can log in using 
that username. This prevents unauthorized users from logging in.

For specific information on setting these restrictions, see the online help located in iManager or 
ConsoleOne. 

Using OpenSLP to Simplify Login
The service location protocol (SLP) was developed so that networking applications such as Novell 
Client for Linux could discover the existence, location, and configuration of networked services 
in enterprise networks. Without SLP, users must supply the host name or network address of the 
service that they want to access. 

Because SLP makes the existence, location, and configuration of certain services known to all 
clients in the local network, Novell Client for Linux can use the information distributed to simplify 
login. In the case of Novell Client, having SLP set up allows users to see the trees, contexts and 
servers available to them when they use the Novell Client for Linux Login screen. When they click 
the Browse button, a list of available trees, contexts, or servers appears and they can select the 
appropriate ones. For example, instead of having to remember an IP address or DNS name for a 
server, users can select the server’s name from a list of avaiable servers. 

SLP must be activated and set up on your Novell servers in order for the Novell Client to take 
advantage of it. For more information, see “Configure and Administer” in the Administrative 
Documentation for OES manual (http://www.novell.com/documentation/oes/index.html?page=/
documentation/oes/oes_home/data/btshgxf.html). 

In addition, SLP is not set up by default on Linux workstations. Novell Client for Linux includes 
a Novell Client Configuration Wizard to simplify the process of configuring your SLP and other 
Novell Client configuration options. 

To set up SLP, complete the following steps: 

1 Run the Novell Client Configuration Wizard and select the SLP Configuration page.

See “Using Novell Client Configuration Wizard” on page 23.

2 When the SLP Configuration page appears, enter the following SLP information for your 
network: 

Enter the Scope List

Enter the Directory Agent’s IP address or DNS name

Check Broadcast Only

Leave the Default Max Results 

3 Complete the Novell Client Configuration Wizard.

4 Log out of the workstation. 

5 Log in to the workstation.
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6 From the Novell tray application, select Novell Login. 

7 Enter your username and password.

8 Click the Tree button and then select the correct tree from the list.

The list of trees is populated by SLP. Seeing the list of trees displayed means that SLP is 
configured and running on your network.
TIP: If this list does not appear, you have not correctly configured SLP.

9 Click the Contest button and then select the correct context from the list.

10 Click the Server button and then select the correct server from the list.

11 Click OK. 

The Novell Client Configuration Wizard provides only basic SLP configuration since this is all 
that is required by the client. However, if other applications on your workstation require more 
advanced settings, you can modify the /etc/slp.conf file to set advanced settings. 

For more information on advanced SLP configuration, check the OpenSLP Web site (http://
www.openslp.org). In addition, the file:/usr/share/doc/packages/openslp/* directory contains all 
available documentation on SLP, including a README.SuSE containing the SUSE LINUX 
details, the RFCs, and two introductory HTML documents. RFC 2609 deals with the syntax of the 
service URLs used in greater detail and RFC 2610 deals with DHCP via SLP. 

Logging In to the Network
1 Do one of the following: 

From the Novell Client tray application, select Novell Login.

Select Programs > Novell > Novell Login. 

2 Enter your user name and password, then click Advanced.

3 Enter the Tree, Context and Server information for the server you want to connect to. 

You can enter a DNS name or an IP address for the Server. 

You can browse a list of available trees, contexts, and servers by clicking their associated 
buttons. 

4 (Conditional) To clear and existing connections before logging in, check Clear current 
connections. 

5 (Conditional) To run login scripts during this login session, select the Script tab and then select 
the options needed to run the login scripts.

6 Click OK.

Logging Out of the Network
1 From the Novell Client tray application, select Novell Logout.

2 Do one of the following: 

2a If you are logged in to only one tree, click Logout.

2b If you are logged in to multiple trees, select the tree or server that you want to log out of 
and then click Clear Connections.
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6 Managing File Security

Novell® OES and NetWare® networks restrict access to network files and folders based on user 
accounts. For example, a user connected to the network using the Administrator account might be 
able to delete or rename a file that other users can only open and edit.

The Novell file system keeps track of the rights that users have to files and directories on the 
network. When users try to access any file on the network, Novell File Services (NFS) either grants 
access or prohibits certain things that users can do with the file.

It is important to note that Linux file rights do not correlate with NFS file rights. When you copy 
a file over from a Linux workstation to a Novell server, the only right that is preserved is the Read-
Only attribute. This also occurrs if you copy files from one server to another using any method 
other than NCOPY from the command terminal. 

For more information on the specific rights on NetWare and OES servers, see “Understand” in the 
Storage for File Services section of the Administrative Documentation for OES manual (http://
www.novell.com/documentation/oes/index.html?page=/documentation/oes/oes_home/data/
bseke41.html).

Rights are granted and revoked by creating trustee assignments. For more information, see 
“Changing Trustee Rights” on page 32.

 This section explains the following:

“Checking File or Folder Rights” on page 31

“Changing Trustee Rights” on page 32

“Combining Multiple Trustees” on page 33

Checking File or Folder Rights
IMPORTANT: This feature is not fully functional in Beta 3.

1 Right-click the file or folder that you want to check.

2 Do one of the following: 

On GNOME: Select Novell Properties.

On KDE and SuSe Pro: Select Applications > Novell Properties.

3 Click the Novell Rights tabbed page. 

4 View the information. 

The Trustees list shows the users or groups that have been granted rights to work with this file 
or folder. For a folder, the trustees rights to the folder also apply to all the files and folders it 
contains unless the rights are explicitly redefined at the file or subfolder level. 
Managing File Security 31

http://www.novell.com/documentation/oes/index.html?page=/documentation/oes/oes_home/data/bseke41.html
http://www.novell.com/documentation/oes/index.html?page=/documentation/oes/oes_home/data/bseke41.html
http://www.novell.com/documentation/oes/index.html?page=/documentation/oes/oes_home/data/bseke41.html
http://www.novell.com/documentation/oes/index.html?page=/documentation/oes/oes_home/data/bseke41.html
http://www.novell.com/documentation/oes/index.html?page=/documentation/oes/oes_home/data/bseke41.html
http://www.novell.com/documentation/oes/index.html?page=/documentation/oes/oes_home/data/bseke41.html


    Novell Confidential                                                                                            Manual (99a)  21 December 2004
The rights that each trustee has are shown by checkmarks under the letters. If you are viewing 
the properties of multiple files, the trustees and rights shown are the combined trustees and 
rights for all the files.

Inherited Rights and Filters displays all the inherited rights and filters that apply to this file or 
folder

Effective Rights displays your effective rights for this file or folder. 

5 Click OK. 

Changing Trustee Rights
IMPORTANT: This feature is not fully functional in Beta 3.

You must have the Access Control right to change trustee assignments.

1 Right-click the file or folder that you want to check.

2 Do one of the following: 

On GNOME: Select Novell Properties.

On KDE and SuSe Pro: Select Applications > Novell Properties.

3 Click the Novell Rights tabbed page. 

4 Select the trustee you want to change rights for from the Trustees list.

5 Check or uncheck the boxes associated with the rights you want to assign to this trustee. 

6 Click OK. 

Trustee assignments override inherited rights.

To change an Inherited Rights Filter, click the Inherited Rights and Filters button on the NetWare 
Rights property page.

Adding a Trustee
You must have the Access Control right to add a trustee.

1 Right-click the file or folder that you want to check.

2 Do one of the following: 

On GNOME: Select Novell Properties.

On KDE and SuSe Pro: Select Applications > Novell Properties.

3 Click the Novell Rights tabbed page. 

4 Locate the user eDirectory object that you want to add as a trustee.

5 Click Add.

6 Click OK. 

Removing aTrustee
You must have the Access Control right to delete a trustee.

1 Right-click the file or folder that you want to check.
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2 Do one of the following: 

On GNOME: Select Novell Properties.

On KDE and SuSe Pro: Select Applications > Novell Properties.

3 Click the Novell Rights tabbed page. 

4 Select the trustee you want to delete from the Trustees list.

5 Click Remove.

6 Click OK. 

Combining Multiple Trustees
IMPORTANT: This feature is not fully functional in Beta 3.

As an administrator, you might need to apply the same trustee assignments to a group of selected 
files. You can combine trustee assignments by selecting the Combine Multiple Trustees option on 
the NetWare Rights page.

For example, Kim is a trustee of FILEA and FILEB. Kim has Read, File Scan, and Access Control 
rights for FILEA and Read and File Scan rights for FILEB. Nancy has Read and File Scan rights 
for FILEA.

If you give a new user named Jack Read, Write and File Scan rights for both FILEA and FILEB 
and, at the same time, you want to give similar trustee rights for Kim and Nancy, check Combine 
Multiple Trustees. The following rights are the assigned:

Kim has Read and File Scan rights to both FILEA and FILEB. Her Access Control right is lost 
because the combined rights are taken from the rights given to Jack.

Nancy has Read and File Scan rights to both FILEA and FILEB. She has gained Read and File 
Scan rights to FILEB because the combined rights are taken from the rights given to Jack.

Jack has Read, Write, and File Scan rights to both FILEA and FILEB.

1 Highlight all the files or folders that you want to combine rights for

2 Right-click the files or folders, then select one of the following: 

On GNOME: Select Novell Properties.

On KDE and SuSe Pro: Select Applications > Novell Properties.

3 Click the Novell Rights tabbed page. 

4 Select the Combine Multiple Trustees Checkbox. 

5 Click OK. 
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7 Uninstalling Novell Client

This section explains how to uninstall Novell Client for Linux

Uninstalling using the YaST Control Center
1 Launch the YaST Control Center

1a From the System menu, select Administrator Settings.

1b In the Run as Root window, type the root password, then click OK.

2 Select the Software tabbed page in the left column to activate it and then select Install and 
Remove Software in the right column. 

3 Change the filter to Selections.

4 Check the Novell Client for Linux checkbox until a trash can appear. This automatically 
selects all of the packages that need to deleted. 

5 Click Accept to delete all of the selected packages.

YaST displays the progress of the uninstall. 

Uninstalling using the Install Script
To uninstall Novell Client for Linux using the installation script, type the following command in 
the command terminal: 

./ncl_install.bsh uninstall
To test the uninstall using the installation script, type the following command in the command 
terminal: 

./ncl_install.bsh uninstall test
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A Troubleshooting Issues

This appendix provides troubleshooting information for known issues related to Novell® ClientTM 
for Linux. 
TIP: If you do not find a solution to your issue here, check the Novell Client for Linux Readme as well as the 
Novell Technical Support Web site (http://support.novell.com).
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B Commands

The Novell Client for Linux provides a set of command line utilities that are available at the 
console terminal. To locate the list of command line utilities included with Novell Client for 
Linux, look in the following location: 

/opt/novell/ncl/bin
Each of the utilities has a man page associated with it that contains information on the utility such 
as a definition, useage, and samples.  You can access a man page for a specific utility by entering 
the following: 

man utility_name
For example, man ncl_tray.

In the man pages, move up and down with the PgUp and PgDn keys. Move between the beginning 
and the end of a document with Home and End. End this viewing mode by pressing Q. Learn more 
about the man command itself with man man command. 
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